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Part of the Ultimate Cellar Management System
WineBase for Windows    Copyright (c) 1992, 93, 94      Ken Tripp.
The GoldBook for WineBase    Copyright (c) 1993, 94      Ken Tripp.
Data in The GoldBook for WineBase    Copyright (c) 1993    Robin 
Bradley.
This file replaces README.TXT, because WineBase is, after all, a Windows application 
and text files are something that belong in that wonderful world of DOS.
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Files on the Disk
The WineBase disk contains these files ...
WINEBASE.EXE 722,176 or 667,136 Bytes WineBase for Windows.
WINELINK.DLL 3840 Bytes DLL used by program.
WBHELP.EXE 51,382 Bytes SFX Archive contains ...

WINEBASE.HLP 77,638 Bytes Windows help file.
DLL.EXE 105,013 Bytes SFX Archive contains ...

WBSHRINK.DLL 6,912 Bytes DLL used by program.
WINEDATA.DLL 52,736 Bytes DLL used by program.
AUSADDR1.DLL 79,616 Bytes DLL used by program.
NEWFORM.DLL 8,960 Bytes DLL used by program.
WINEMAKE.DLL 6,912 Bytes DLL used by program.
BWCC.DLL 151,984 Bytes Borland Custom Controls.

MAP&FILE.EXE 232,593 Bytes SFX Archive contains ...
SAMPLE1.SDB 22,059 Bytes Sample Database file.
SAMPLE1.SNF 13,056 Bytes Sample Note file.
SAMPLE1.INF 3,804 Bytes Sample Info file.
WINE????.SDB ? Bytes Winery Database files.
WINE????.SNF ? Bytes Winery Note files.
WINE????.INF ? Bytes Winery Info files.
????????.BMP ?Bytes Map files.

WBMANUAL.EXE 235,520 Bytes SFX Archive contains ...
MANUAL1.DOC 1,801,244 Bytes DOC file
MANUAL2.DOC 3,369,146 Bytes DOC file
MANUAL3.DOC 1,209,039 Bytes DOC file
Which together make up a 40 page (A4) manual in Word for Windows 2.0 format.

README.HLP 37,960 Bytes This file.
EXPAND1.BAT 670 Bytes DOS Batch file used by DECANT.
EXPAND1.PIF 545 Bytes PIF file to run EXPAND1.BAT
EXPAND2.BAT 551 Bytes DOS Batch file used by DECANT.
EXPAND2.PIF 545 Bytes PIF file to run EXPAND2.BAT
DECANT.EXE 56,576 Bytes Installs WineBase (Run from Windows 
only).

Creates a directory for WineBase
Copies the Files
Expands the Archives
Deletes the Archives
Creates a Program Group in Program Manager
Installs Program and Document Icons 
THISFILE.WBS 732 Bytes, Needed to upgrade from v1.8 and prior.



System Requirements
Software:

DOS 5.0 or later
Windows 3.1 or later.
Windows for Workgroups 3.11 or later
Windows NT
OS/2 for Windows 2.1 or later

Hardware:
Any computer that runs Windows well (ie 386SX / 2 mb up).
Windows and WineBase are much happier running on a 486 with 4 mb of memory, and 
486's are happier running with 8mb (or 16mb).
1000 kb of memory (free that is). 
VGA 640 X 480 is minimum display requirement.
It will not run at EGA resolution (640 X 350).
Looks much better at 1024 X 768 resolution.
Hard Disk with 9.5mb of free disk space.
The manual needs 6.1mb but can be deleted after printing.

Not a PC:
I have not at this stage any plans to write a version of WineBase to run on that other type 
of personal computer.

Known Problems:
286AT's
This program will not run on a 286 AT with only 1 mb of memory. If the program starts 
'missing things' then lack of memory is the probable cause. In order to use all features of 
WineBase you will need about 1 mb of free memory.
WineBase has been written for speed, the drawback of this is that is rather memory 
hungry.
Video Cards
A few people have experienced problems with GPF's in module GDI.EXE. WineBase does 
not call any GDI functions in a way that is unusual, and upon investigating the matter it 
seems that certain video cards (their Software Drivers) are the cause of the problem, and 
not WineBase.



Legal Nonsense
Product:

WineBase for Windows
Copyright:

WineBase for Windows Copyright (c) 1992, 93, 94    Ken Tripp. All Rights Reserved.
For what its worth, WineBase and the Reference Files and Maps it contains are copyright, 
and may not be used, extracted or reverse engineered without the written permission of 
the author. I would also like to lay claim to a number of techniques used in the program, 
but with the ability to pull apart executable files these days, well, nothing is sacred.

Purpose:
WineBase is intended as a tool for managing home wine cellars. It is supplied as is, for 
you to use how you like.

Warranty:
KEN TRIPP MAKES NO WARRANTY OF ANY KIND, EXPRESSED OR IMPLIED, INCLUDING 
WITHOUT LIMITATION, ANY WARRANTIES OF MERCHANT ABILITY AND/OR FITNESS FOR A 
PARTICULAR PURPOSE.

Disclaimer:
THE AUTHOR ASSUMES NO LIABILITY FOR DAMAGES, DIRECT OR CONSEQUENTIAL, WHICH
MAY RESULT FROM THE USE OF WINEBASE.

Trademarks:
Windows, Windows for Workgroups, NT, Word for Windows,VB are registered trademarks 
of Microsoft Corp.
Borland Pascal is a registered trademark of Borland International.
OS/2 for Windows is a registered trademark of IBM.
Any other trademarks belong to whomever they belong to.



Background
Description:

WineBase is a Windows based Wine Cellar DataBase. It stores information on up to 1200 
different wines (per file). Provides graphical display of wine maturity, cellar value and 
total stock. Graphs the structure of your cellar. Search on most fields. Choice of sort 
options. Prints sorted reports. Easy to add wines or edit existing stock. Keeps Transaction 
Files, tracking comings and goings, and you get to use both Mouse buttons!
WineBase and the GoldBook are shipped on Australian made disks.

Release:
This is an evaluation copy of WineBase for Windows.
(Registered user's please ignore, this file common to both releases.) 
It is fully functional for you to try for a limited time. This program is SHAREWARE, if you 
continue to use it you are expected to send the rather modest sum of $20 (or $40) + $5 
(or $10) postage to the author.
You will receive the latest REGISTERED version, which may well include new features (see 
Development History) and my thanks.

Last Update:
14 May 1994

Version:
Currently 2.6

Language:
Written using Borland Pascal with Objects v7.0, from Borland International Pty Ltd, an 
excellent programming language.
Who needs C++, VB is a toy and real men program in Pascal etc.



How to contact the Author
Author:

Ken Tripp
Postal:

P.O.Box 221
Black Rock VIC 3193
AUSTRALIA

Phone:
+61 (03) 589 3414 (9am - 10pm, 7 days)

eMail:
InterNet ken.tripp@blaze.bbs.net.au
CompuServe 100035,2460
Both these networks can be accessed from each other or from other systems.



Feedback, Bugs and Support
Feedback:

If you have any suggestions about how to improve this program, or features that you 
think should be added, phone, eMail or write to me and let me know. The development 
of WineBase is not limited to what I think the program should have. Everyone using it is
involved in the process, and in a small way it can be considered as customised 
software, because even though you are not actually making the changes, your ideas 
are incorporated, and you end up with software that does what you want.

Bugs:
The term Fast Track is applied to a lot of things, and is generally used to describe the 
accelerated development of a project. This term can certainly be applied to WineBase.
In order to continue developing WineBase at the fastest possible rate and therefore 
provide you with the best possible software, I have adopted the following policy ...

When a new feature (or several) is included in Winebase, I test it for a while and when
I am sure that it works OK (I don't always get this right), I then ship that version.

This occasionally leads to a version of the program that, to put it in the kindest possible
terms, 'has a few problems'.
If you find a problem with WineBase please let me know about it. Chances are, that it 
has already been brought to my attention, but it may not have been.
If you are evaluating WineBase, and are put off registering it, because it appears to be 
doing something wrong, let me know. The problem may well have been fixed.
If you are using a registered version, and find a problem, let me know. Not only will the 
problem be fixed (if it hasn't been already), but you will be sent the latest 'Bug Free' 
version FREE.

Support:
Some people think that because WineBase is so reasonably priced, that they shouldn't 
bother me for support, when they're having some difficulty with some aspect of the 
program.
I don't mind getting letters, eMail or phone calls about topics that you might think are 
too trivial to raise. If you are having a problem then the phone is the most effective 
method, as sometimes, questions and response's have to flow back and forward to get 
to the bottom of things.
Support for WineBase is FREE. I will not be asking for your credit card number, or 
keeping track of how many times you contact me.
I check my mail box daily, both Postal and eMail, and the phone is never of the hook or 
diverted to an answering machine. If I'm here then its answered.
Like most people involved in software development (small scale) I tend to work best at 
night, which can often extend into the not so early hours of the morning. Keeping this 
in mind, I am usually more responsive to phone calls in the afternoon. By responsive, I 
mean that my brain will be ticking over enough to understand and respond to your 
questions.



Distributing WineBase
Distribution:

You are free to copy the evaluation disk, and to give copies to your friends, upload it to 
BBS's, FTP sites etc, as long as all files are included and not altered in any way.
ShareWare libraries are free to copy and distribute this program as long as the price 
charged is on a recover costs basis.
Putting it in a box, printing a manual and selling it as cheap software for $20 to Joe public,
with no mention anywhere that it is a shareware product, is not on.

Cost:
You should not have paid much more than $5.00 - $10.00 for an evaluation copy of 
WineBase.



Registering WineBase
Why Register:

By registering WineBase you are not only providing me with the incentive to continue 
developing it, but it ensures that you using the latest version, and that you will receive 
notice of future upgrades.

Pricing Details:
Registered copy of WineBase A$20.00
The GoldBook for WineBase A$20.00
A printed A4 User Guide A$10.00
Postage and Handling A$ 5.00
Postage and Handling for orders from outside Australia is A$10.00
I accept Personal Cheques, Bank Cheques and Money Orders, and have even been 
known to barter for a registered copy of WineBase. Credit Card facilities will be 
available from July.
WineBase will soon be on CompuServe, and you will be able to register it via GO SWREG.
I have not yet determined a price for this but it will be slightly higher than the above 
figures, due to commisions that have to be paid to CompuServe.
The Help menu in WineBase has additional information on Pricing and Registration.

Registration:
The Help menu has an option 'Print Registration Form', which has a dialog where you can 
enter your address details etc and then print a letter to send to me.

No printer ?
If you do not have a printer, then send you full name and address details (please print), 
and if you like, some information on your computer system.
A registered copy of WineBase has your name and address on it, which you cannot 
change. So if you would prefer John Smith rather than J. Smith, I need to know that your 
first name is John.



Installation
How to Install WineBase:

A Setup Program called DECANT is included or you can install the program manually.
WineBase does not alter your WIN.INI file.
You do not need to alter your CONFIG.SYS file, but you should check that the line FILES = 
50 is included.

1: USING DECANT (highly recommended)
From Windows Program Manager.
Select RUN from the FILE menu.
Type A:DECANT (OR B:DECANT if your 3.5" disk is drive B: in the Command Line Edit 
Field).
Click on OK to execute the Program.
Decant is a Windows Application with two functions.
INSTALL:

Creates a Directory for WineBase (C:\WINEBASE is default).
Copies the Files from the Floppy Disk.
Expands the Archives and then deletes them.

SETUP:
This program creates a WineBase Program Group in Program Manager.
Adds Icons for WineBase and other files to the WineBase Program Group.

2: TO INSTALL MANUALLY 
WineBase is best installed in its own directory.
IT MUST BE INSTALLED ON A HARD DISK!
Suggest: C:\WINEBASE or D:,E:,F: etc
1. Create a directory.
2. Copy all files there.
3. Expand the Archives.

Eiither at the DOS prompt by typing the name and pressing ENTER.
OR
From File Manager by Double clicking on the file name.
DO NOT DO THIS ON THE FLOPPY DISK AS THE TOTAL FILE SIZE IS NEARLY 11 mb.
Program Files = 3.4mb
User Guide        = 6.1mb
GoldBook            = 1.3mb 

4. Install WineBase via Program Manager.
5. Select File / New

Program Item [OK]
Description        WineBase
Command Line      C:\WineBase\WineBase.exe [OK]

FILES CREATED.
When first run WineBase will create 9 data files.



WINEBASE.DTA, 
WINENOTE.DTA, 
WINEINFO.DTA,
NETWORTH.DTA, 
SCHEDULE.DTA,
RACKFILE.DTA,
MYCELLAR.DTA,
MAPFILE.DTA and INTNAT.WBS.



Thanks to
Many people have helped with the development of WineBase (and still are), too many to 
list in fact. If you have found a bug or made a suggestion of a new feature to be added, or 
a way of improving the program, then I (and the other WineBase users) thank you.
Some of the more notable are listed alphabetically below, with some details of how they 
have helped.
If your name isn't on this list and you think it should be. Get in touch and remind me why.

Gordon Barrington, for numerous suggestions, many of which you are now using.
David Buckwalter, for his ideas and feedback on the Tasting Schedule facilities.
Robin Bradley, for his help with the GoldBook for WineBase, and for general comments 
that have improved the program.
Evan Brown, for bringing WineBase to the attention of the good people of Adelaide.
Russell Collins, for the information on French wines.
Sandy Dunn, who suggested the Variety vs BestAt table, which also resulted in the new 
Variety vs BestAt graphs.
Mark Emery, for reminding me that some people do in fact use a LapTop with a Mono 
screen.
Duncan Goldsmith, for testing, feedback and help on South African wineries.
Jack Haley, for constant feedback on the problems WineBase had in printing to a HP 
LaserJet.
Larry Jones, for a number of suggestions, one resulting in the addition of the BestAt 
graph.
Dick Lovegrove, for feedback, his ideas on fuzzy logic and for being one of many to try 
and get the Wine Society to see the benefit of WineBase.
Ron Lyth, Dr Blaze BBS.
+61 (03) 890 9323 (2400) 7 lines
+61 (03) 899 0011 (9600) 3 lines
for putting WineBase in the Product Menu, thus allowing anybody to download it, and for 
his advice along the way. Ron also runs ARTEL Computers and is a Pascal Development 
Consultant.
Greg McTiernan, with an eye for detail that only a retired accountant could have, the 
best bug finder in the business, with documentation to match.
Jim and Louise Montgomery, for a couple of suggestions, one of which resulted in the 
DataBase engine being rewritten for speed, and another resulted in 'Locked' titles being 
added to Tables.
Rachel Morrison, for her patience and understanding, a lot of data entry, and for not 
taking to my computer with an axe (so far at least).
Patrick O'Sullivan, for his suggestions on how to get WineBase better known, and for 
being enthusiastic enough about the program to upload it to CompuServe, and giving it a 
plug on the Bacchus Wine Forum.
Gerry Prewett, for feedback and encouragement, chasing down sources of information, 
sending WineBase to all corners of the world via InterNet, and telling everyone he knows 



about the program.
David Priebbenow, for suggestions and feedback and for his work in getting WineBase 
on a number of bulletin boards around the country.
Kevin Rasmus, for suggestions, one of which became the 'Quick Drink' function, we all 
like to use.
David Ripper, for helping me sort out version 1.3, and getting the whole thing started 
(1st registration).
Rod Studholme, for introducing WineBase into the Armed Services.
Stephen Vey-Cox, for reference material, testing, feedback, introducing WineBase to the
Wine makers of SA (McLaren Vale and Clare), and for promotion of the program within 
Australian wine circles and overseas.
John Wood, it was John's suggestion to link GoldBook Winery info to the Regional info 
(via the AUST map).



Development History (Part 1)
More like an epic saga than a development history (film rights available).
Jun 1992 Ver 1.1

Written for my own use as available programs were found to be inadequate or too 
general.

Aug 1992 Ver 1.2
Why not share it? Beta testing and feedback.

Jan 1993 Ver 1.3
Major rewrite.
Problems with printing fixed.
A facelift for all displays.
Added a notes field.
Added 2 Graphs and 3 Tables.
User defined Wine Types.
Easy Search and Easy Edit added.
Upgraded file structures.

Feb 1993 Ver 1.4
A Non Vintage option added for fortified wines.
Help file rewritten.
Sorting options for screen and printer.
All graphs now sorted alphabetically.
New menu structure including Dynamic Wines menu.
Multiple field search added
.Added a one page Health Report.
Produced a manual.

Apr 1993 Ver 1.5
Added support for 800 X 600, 1024 X 768, 1280 X 960, and 1280 X 1024 VGA modes.
Fixed up problems with Dialogs in these modes.
The Main Window is now user sizable!
Changed Double Click to Single Click in Index Window.
Added sample data files and Winery files.
Changed some List Boxes to Drop Down Lists. 
Added an eight line notes field.

May 1993 Ver 1.6
Added a status line at the bottom of screen.
Fixed a bug in the "notes" file.

May 1993 Ver 1.7
Main data files now use minimum size needed, this saves 1.5mb of disk space.
Improved performance with large data files.
Added a separate Window to display Winery information, and to enter this information.
Added the ability to create multiple data files.
You can edit Winery files if you created them.



Development History (Part 2)
June 1993 Ver 1.8

International version, date and currency.
Control over Dialog Box colours.
You can now change the "Comment" fields title, this is now also a Search field.
Non Vintage listed as "Non Vintage' not "9999"
Cellar Location now listed in INDEX and PRINT.
You can sort by Location to Screen and Printer.
You can now Search on Location as well.
New Graph showing showing Wines and Bottles that will be at their best in coming years.
New Check Age options. Wines at their best now and wines at their best in some future 
year.
Improved the quality of print output.
Improved the Status Line.
You can now duplicate wines. (since removed)
New Index Menu structure.
Fixed a Bug with printing multiple pages.
All index functions in one Dialog Box.
New Menu structure and Print options.
'Colour' options for LCD Mono screens.

June 1993 Ver 1.9
Added a 'WineBar' of buttons for most functions.
Improved the speed of the program.
The Edit Dialog in particular (about 1000%).
Fixed bugs with Graphs (Over writing).
Fixed bugs with Tables (Missing chunks).
Added a new Ageing Graph and a TimeLine Table.
Added SpreadSheet Import and Export.
I seem to have fixed the problem when printing to laser printers.

July 1993 Ver 2.0
New Menu structure for Winery Files.
You now have 110 protected file numbers.
Split WineBar into Edit and Graph bars.
Added a Map Display function.
Locked the Titles on the Tables.
Wine and Bottle display options for graphs.
Detailed and Brief Printed output.
New All Years Best At Index listing.
You can now DELETE wines.
Global Search and Replace.
Printing of Health Report, Page Display Page.
Main Edit Window stays open to allow for multiple entries.
Printing of all the Graphs (except Stock and Value)
Fixed bug with Backup function (it now works)
Total Bottles listed in Index Listings.

Aug 1993 Ver 2.05.
Fixed bug with print header (date ?).
Replaced NVin with Prior wines in Best At Graph.
Removed Duplicate function (messy, and possible cause of problems??? May come back).
Added a 'Quick Drink' function.



Added Cross Reference files. Winery to Region.
Label is on the way ???.
Fixed bug with Small and Normal in INDEX screen.
Replaced with ZOOM (100%, 75% and 50%).



Development History (Part 3)
Sept 1993 Ver 2.1

Added ability to use True Type fonts.
WineBase runs only on Windows 3.1 from now on.
Tasting Schedule and the ability to 'flag' wines that need to be checked in future.
Hot Spot for 'Quick Drink'    "Stock"
Hot Spot for 'Tasting Schedule' "Health"
Added installation program SETUP.EXE 

Oct 1993 Ver 2.2
Australian Winery Reference section started.
Added ability to view regional maps from map of Australia (Tas and Barossa at moment)
Fixed a rather elusive bug that has been the cause of "holes" appearing in the data file.
New file format with two extra fields 'User 2' User definable, Search and Sort on, 'Value' of
a wine as opposed to cost. Stock / Value graph now works of this.
Cleaned up the Schedule and General Notes windows.
New Help file, shorter and more useful help.
Added "Spread" for "BestAt" date when searching for wines to drink now (Options menu).
Displayed as glasses on Page Display. 
New Maturity graph in Page Display.
New menu structure (follows CUA guidelines).
SETUP is now called DECANT (why not).
New default values for Grape Varieties (have erred on the low side, which will match 90% 
of wines, please adjust for quality long lived wines). 

Nov 1993 Ver 2.25
Total Value and Stock now match Health Report.
Value figures are now correct (which helps !!!)
Added some more maps (Coona,Geelong,Margaret,Mornpen), and NorthTas has been 
redrawn. More maps are coming, and if you have a map of a region (preferably a .BMP), 
put your name on it and send it to me.
Drop down lists in Main Edit dialog now update as you save a wine (used to update only 
when Dialog opened).
Wines in Danger now include wines in second half of decline (Danger + Decline on 
Options menu).

Nov 1993 Ver 2.3
Upgraded my compiler to Borland Pascal 7.0
Program now uses Borland Dialogs rather than Microsofts.
You have a choice of 8 dialog background colours, use the Options / Preferences menu to 
select.
Finally (and I know I have said this before) fixed the Value and Price figures.

Jan 1994 Ver 2.4
New Table Variety vs BestAt vs Bottles
New Graph Variety vs BestAt (for each Variety)
Two new buttons to go with the above
Access to the GoldBook for Winebase is now included.
INDEX listings are updated after editing
Transaction files added (Purchase and Usage)
Spreadsheet Import / Export revamped.
Fixed a problem when printing to colour printers.
Added a whole heap of maps, more on the way.



Installation of Manual now optional in DECANT.
Cleaned up some of the Dialog boxes.
Index listing dump to a Text File added.



Development History (Part 4)
Mar 1994 Ver 2.5

Wines best to drink now can be can be narrowed down to a single variety.
Search for 'Lost Souls' button replaced by search by Stock Level (including 'Lost Souls').
Improved the GoldBook to Main Edit interface, Search on Vintage and Winery, exports 
Label,
Variety and even finds the Region (optional).
Wines to be tasted now, now cover 3 months not 2
Search for wines not tasted (prior date, no comment).
Cellar Mapping introduced.
Drop Down Lists in GoldBook Search Window.
Added 'Hint Text' to the Status Line for buttons.
Extended the Tasting Schedule dates (search for) to cover 3 month blocks for the next 
year.

Apr 1994 v2.6
Multilple field Dialog now does something useful.
You can now add a TEXT file for each wine (8000 Char), you can Paste from ClipBoard into 
this file.
Added a Floating menu to the INDEX listing (Vint). 
Linked GoldBook Winery info to Regional info (AUST map).
List all wines for tasting for next 2 years (by month).
New SysInfo Window (GDI and User Heap shown).
Low Resources Warning (<25%) added to Status Line.
Fixed Bug with Spreadsheet Import (Bin Locations).
Fixed Bug with Cellar Mapping (Main Edit Dialog).
Increased total Bins to 512 (6144 Bottles total)
Updated the French regional information (466 wineries) with Region and Appellation info.
Regional Info Dialog now available from View menu.
Fixed a couple of 'Leaks' (GDI).
Added Resource Monitor to WineBars (800X600 SVGA + only).
Cleaned up the Help File. 
Fixed Bug with the Popup Menu in Index screen.

(May 1994 2.7B ?)
Revamped Winery to Region Dialog, Country now stays on the last one selected. Gets a 
button on WineBar.
Added 169 South African, 131 New Zealand Wineries.
Removed Search/Sort to Printer option (redundant).
Fixed what I hope is the last Bug with Cellar Mapping.
Modified Main Edit Dialog (grayed buttons) giving better 'flow' when adding a new wine.
Fixed bug with DELETE wine function. 
Wrote a NEW Help File for WineBase.
Added PIF files to run batch files in Window.
Replaced README.TXT with README.HLP
Hint Text for Buttons no longer requires you to click the Button, responds to mouse 
position.
Added an Australian Flag (animated) to the About Dialog.
Fixed the last inconsistancies in the GoldBook data.
Initial About Dialog (with the flag) now clears itself.
Spreadsheet import now imports 0,1,2, and 3 decimal placed Prices and Values correctly.
Notes and Tasting Schedule windows now update correctly after editing (long lines).
Increased the width of both the Notes and Tasting Schedule Windows.





Reviewers Comments
If you are one of those people that like to read other peoples thoughts on a program, then 
here are a few, with my comments in red ...
Sue Lowe (The Sydney Morning Herald, 9th May 1994)

We reviewed it a year ago when it was a shareware program and a little bit on the rough 
side. Now it is commercial and a bit more expensive, but somewhat smoother.
(A commercial version with nice packaging and a very nice manual is available for $99).

Nameless ? (Software Express Catalogue, 1994)
Slightly eccentric in its operation, neverthless it provides a wide range of features and an 
incredibly wide range of views of your cellar`s contents.
The icons are lovely, but, you have to click a master icon then click a sample one to find 
out what they all mean.
(Some programmers might take exception to the first 5 words of this, but I don't mind at 
all. The buttons now feature a full description by just passing the cursor over them).

Ali Kayn (Melbourne AGE newspaper, 14th Dec 1993)
This program has a lot of user-oriented features. Admittedly, it is a Windows program and 
the iconography can be a little obscure, but it has been designed from the very first day 
in conjunction with the actual users. As a result, it is what the user wants, not what some 
nameless programmer thinks would be useful.
(The advantage of Shareware).

Glenn Rees (Australian PC User, Aug 1993)
WineBase certainly wins points for its nice range of bar charts and colour coding to help 
you become the ultimate cellar master.
(I agree, but whether we'll all become ultimate cellar masters is another question).

Sue Lowe (The Sydney Morning Herald, 24th May 1993)
WineBase is a very professional-looking program which runs on Microsoft Windows. Mr 
Tripp provides a manual on the same disk as the program and this prints up to a smart-
looking, easily understandable 21 pages. But if you have any Windows experience at all 
you won't need it. WineBase is very easy to use.
(You see, anybody can use it).




